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Workgroup Internet Gateway








What does it do?





The Workgroup Internet Gateway (WIG) allows a group of users to individually send and receive E-mail from their own workstations over the LAN with only one of the machines on the LAN requiring a modem. 





What mail clients does it work with?





WIG is a 32-bit MAPI driver and so will work with any MAPI enabled application. It is intended mainly for use with MS Exchange.





WIG also comes supplied with a 16-bit extension to MS Mail which allows MS Mail users to seamlessly send Internet mail via the WIG. It is a requirement that the WIG gateway machine is running Windows 95.





Note that the MS Mail extension will only work with the MS Mail client provided with Windows for Workgroups 3.11.





What you need to send mail over the Internet





In addition to this product, you will need:





a modem or other connection hardware


subscription to an Internet provider via a dial-up line or direct connection with collection of mail using either POP3 or SMTP.


dial-up networking installed (supplied with Windows 95)


TCP/IP networking installed (supplied with Windows 95)





How does WIG Work?





WIG expects that one machine in your workgroup be designated the Gateway machine. The Gateway machine must be connected to a modem. It is responsible for sending and receiving Internet mail for the entire workgroup. 





Whenever a WIG user sends an Internet message, the message along with all the recipients and attachments is written to a JET engine database. The Gateway machine will periodically connect to the Internet in order to check for pending incoming messages for the workgroup. 





When the Gateway machine connects, it will check the JET engine database for messages waiting to be sent. It will send those messages. Any messages coming down from the Internet will be written to the JET engine database. 





Both Gateway and non-Gateway machines will periodically check the JET engine database for messages sent to them. These messages will be brought into MS Exchange and displayed as normal incoming messages into the In box.





Note: WIG must be installed as a service on each Windows 95 machine. At least one of the machines should have their WIG configured as a gateway machine. All other machines must be running WIG configured as a non-gateway machine.
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WIG Workgroup configuration





WIG works with MS Mail in the following way:





MS Mail users each load an extension DLL which realises when you have addressed a message to an Internet recipient and instead sends the message to an Internet mailbox/profile. WIG then reads all messages sent to the Internet mailbox/profile and adds the messages to the JET engine database and then sends them in the normal way.


On receiving a mail message from the Internet destined for an MS Mail user, WIG realises that the recipient is an MS Mail user, repackages the mail message and forwards it directly to the MS Mail user via MAPI.
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WIG Configuration for MS Mail connectivity
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Setting up the gateway for Windows 95





Unzip the files supplied in WIG.ZIP into a temporary directory. Double click on Setup.exe.
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Run Setup.exe





Specifying your details





When you run the Setup program, you will be presented with a Welcome page. 
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Welcome page





Press Next. The Database page will appear.





�





Database page








A Data source name is simply a name (of your choice) that you provide to represent the WIGs connection to the shared message store. ‘INTERNET_MAIL’ is provided as a default. 





If you are the first user setting up the WIG then you will need to specify a Message Store Filename which is a .MDB file on a shared disk which all users will be able to see. The database file will be copied to the pathname that you specify. The directory (in the case of this example s:\win95) must exist. You should specify a filename with a .MDB extension. If this field is disabled it means that the Data Source Name already points to an existing WIG database. This will only likely happen if you have previously installed WIG on the machine.





Note: If you are a subsequent user, setting up the WIG after the shared Message store database has already been established, then you should still specify ‘INTERNET_MAIL’ as your data source name, but you should use the Browse… button to locate the .MDB file created by the administrator (the first user that setup the WIG).





When you have entered the relevant information, Press Next.
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Workgroup page





If the database did not already exist then the software assumes that you are the WIG administrator and displays a Workgroup page where you should enter Workgroup details. If the Workgroup page appears and you know that the workgroup has already been setup by an administrator then check that you specified the correct path for the shared message store on the previous page.





The Workgroup page lets you specify a name for your workgroup and requires that you specify a node address. The node address will often be the same as the latter part of your e-mail address. For example, if your e-mail address was bob@softalk.demon.co.uk, your node name would be softalk.demon.co.uk. However if you have a domain name setup, e.g. softalk.co.uk and you are receiving using SMTP rather than POP3, your node name is often different from your domain name. For more information on specifying your Node Address, see Node names and Domain names later in this manual.





If you receive using a multiple POP3 account, you must enter the Login Name and password of the POP3 account in this dialog box.  If you have several POP3 accounts then leave the Login name and Password fields blank, but ensure that every user specifies their POP3 account details in the Login Name and Password fields in the User dialog box.





When you have entered the relevant information, Press Next.
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User page





The User page lets you add yourself as a user of the WIG. Enter your full name and your mailbox name. The mailbox name entered in this example is ‘simon’. This mailbox name is combined with the Node Name specified in the Workgroup Page (only administrators see this) to make up your mail address. The mail address of ‘Simon Bates’ is therefore simon@softalk.demon.co.uk.





If your company has several individual single user POP3 accounts (i.e. one for each user instead of a single multiple user POP3 account) or you as a user have a different POP3 account than the workgroup, but with the same Internet provider) then enter your POP3 login name and password in the relevant fields.





When you have entered the relevant information, Press Next.
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Modem Page





This page lets you specify whether or not your machine will be responsible for connecting to the Internet in order to send and receive mail. If it will be responsible then select the Yes radio button. Otherwise, select the No radio button and your machine will use the shared database.





If you select the Yes radio button, then specify whether or not you have a direct connection or a dial up connection to the Internet.





When you have entered the relevant information, Press Next.
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Host Information page





The Host Information page will only be displayed if you specified that you do have a machine which will be responsible for connecting to your Internet Provider in order to send and receive mail. If you selected the No radio button in the Modem page then the page after the Modem page will be the Connection page.





The WIG needs to know your Mail Server Internet Address. The Mail Server Internet Address represents the computer which handles the delivery of your mail. This is an Internet address of the format machine.provider.co.uk or post.provider.com etc.  The WIG needs to know this address so that it can transfer mail between your computer and the Mail Server Computer. If you do not know the Internet address of your Mail Server, then contact your Internet provider company. 





You should select SMTP/POP3 as your server type unless your Internet provider does not support POP3 mail retrieval in which case select SMTP Only. Create a new dial up connection or select an existing one from the Dial-Up Connection drop list.





When you have entered the relevant information, Press Next.





The Attachments page will only be displayed if you specified that you do have a machine which will be responsible for connecting to your Internet Provider in order to send and receive mail. 
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Attachments page








This page lets you choose the way in which you format attachments when sending binary data over the Internet.





Note: Only registered users may send binary files over the Internet. Non-registered users are restricted to sending text only. Non-registered users can however receive binary files.





By default, the gateway sends binary attachments in a UUEncoded format. If you wish to send your messages as MIME formatted messages (which also handles the encoding of binary files) then select the MIME radio button. When you have entered the relevant information, Press Next.
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Connection page








When to Send and Receive Mail





If yours is a gateway machine, WIG will connect to the Internet in order to send pending messages and check for new mail, at regular intervals. You can specify the frequency of these intervals from the Connection page. Both gateway and non-gateway machines check the database for new messages at regular intervals. You can specify the frequency of these intervals from the Connection page. In the above example, WIG is set to connect to the Internet every 30 minutes and check the local message database every 2 minutes.





You can ask the WIG not to connect to the Internet as soon as Microsoft Exchange starts up. Do this by un-checking the On Exchange startup check box. 





You can ask WIG not to display a prompt message box prior to connecting to the Internet. Do this by un-checking the Prompt before Connect check box.





When you have entered the relevant information, Press Finish.





Setup will then copy the relevant files to your hard disk. If there is a problem copying the files, then setup will pop up a dialog box containing a specific reason why the copying process failed. If the copying process is successful, the following dialog box will be displayed.
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Successfully installed











The gateway is now installed and may be seen as an un-installed service in Microsoft Exchange. All that remains now is to install the service in MS Exchange.








Installing the Workgroup Internet Gateway (WIG) Service into MS Exchange





Once you have installed the WIG, as described above, run up Microsoft Exchange. If MS Exchange is not installed on your system then you will need to do this.





When MS Exchange starts up, it will see the Workgroup Internet Gateway Service, but it will not have installed it as an active service. To do this, select, Services from the Tools menu.
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MS Exchange menu








When you select this menu item, the Services dialog box will appear.
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Services dialog box





Press the Add button on the Services dialog box. The Add Service To Profile dialog box will appear.
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Add Service To Profile dialog box








Select Workgroup Internet Mail and press OK. As soon as you press OK, the Internet Gateway Settings property sheet will be displayed. 
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Workgroup Internet Settings property sheet








The details sheet will be displayed and the User drop list will either be blank or will contain your name. Ensure your name is selected from the drop list. Doing this lets the Workgroup Internet Gateway know that this workstation is yours and your mail should arrive at this machine. When you have done this, press OK. The service will be added to your profile. Close MS Exchange and restart it. The Workgroup Internet gateway will now be installed in MS Exchange. If you have Dial-Up networking correctly installed, you should be ready to send and receive messages. For more information Dial-Up Networking, see Installing Dial-Up Networking in Windows 95.








Note: The Internet Gateway Settings property sheet displays all the information that you specified during the Setup process. It also provides some additional functionality that was not displayed during the Setup process, such as extended connection options and MS Mail connectivity options. For more information on connecting MS Mail clients to WIG see Using MS Mail with WIG later in this manual.





Specifying Host Details





The Host page displays all the settings that you chose during the Setup process regarding the Internet Service Provider and your connection type. 
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Host property sheet





This page lets you specify an address for your Internet Service provider’s Mail server address. In most cases the address that you supply in the Mail Server Address field refers to a server which handles both sending and reception of mail. Sometimes, however, providers have different servers for sending and receiving mail. If this is the case then you should supply the address of the server  to which you send mail in the Mail Server Address field and then press the Advanced… button to specify the address of the server from which you receive mail. When you press the Advanced… button the Host Server Receive Address dialog box will appear. Enter the address of the server which you use to receive mail.
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Host Server Receive Address











Specifying Connection and Disconnection Options





To specify connection and disconnection options, select Workgroup Internet Gateway from the Services dialog box in MS Exchange and press Properties. Then select the Connection Tab. The Connection Property sheet will be displayed.
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Connection property sheet





This property sheet lets you specify when a connection to the Internet is made. If you wish to connect when MS Exchange starts then select the Connect to the Internet on Exchange startup check box. 





Sometimes other services inside MS Exchange require exclusive access to certain resources (such as modems) during the MS Exchange initialisation process. For example the MS Fax service requires exclusivity to attached modems for about 5 seconds after MS Exchange starts. This property sheet lets you choose a delay prior to the WIG attempting a dial up connection. In the example property sheet above, the delay is set to 5 seconds.





You may also specify how often you connect to the Internet in order to send and receive mail to and from your workgroup.  In the example property sheet above, the connection frequency is set to 30 minutes.





You can ask WIG to disconnect after a certain period of time. You can do this by checking the Disconnect automatically after n minutes check box. If you do this, WIG will disconnect after n minutes or after it has completely finished sending and receiving mail from the Internet, whichever is the later. If you want WIG to prompt you prior to disconnecting then ensure that the Prompt before disconnection check box is selected. You can force WIG to disconnect even if it is the middle of transferring mail. Mail messages will never be lost since if disconnection is made part way through a mail message arriving or being sent, WIG will not confirm receipt or transmission of the message and so it will be resent on subsequent connection. To force disconnection, press the Advanced… button.
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Advanced dialog box





This will pop up the Advanced dialog box. There are three options to choose from: You can choose either not to force disconnection (the default), or to force disconnection after prompting with a message box, or to force disconnection regardless. Select the required option and press OK.





If you wish WIG to connect to the Internet silently then ensure that you un-check the Prompt before connection check box.





Note that if you wish to have a completely automated process for logging onto the Internet then you need some form of Dial-up networking. Dial-up Networking is available on the Microsoft Plus CD.





Logging Errors





If WIG should have any problems such as writing or reading to and from the database. This can happen, for example, if the server computer containing the shared database MDB file is down. Such errors should generally be reported to either an administrator or a user. This page lets you specify who gets the error messages and how. The check box lets you pop up a message box when WIG encounters any errors on the machine which encountered the error. The second check box, if selected, will route errors from that machine to the administrator in the form of a mail message. The third check box if selected will log the error in the database. Using this option, the administrator can peruse any errors from all machines from the WIG Administrator program.





�





Errors property sheet





The WIG Administrator Program





When you install the WIG for the first time and specify a new workgroup, an executable file WIGAdmin.exe will be copied into your Windows directory. This program enables you to administer the workgroup gateway postoffice. Run the program by double clicking on it from within the Windows Explorer.





When you first enter the Administrator program, you are asked to enter a a password and a verification of the same password. Once entered, this will be the password you need to get into the WIGAdmin.exe program.
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Initial password request





Whenever you subsequently run the WIGAdmin.exe program, you will need to enter this password into the Enter Password dialog box which appears on running the program.
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Enter password dialog box
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WIGAdmin.exe program





Using Workgroup administrator program, you can add, edit and delete users and modify details about your workgroup. When each subsequent user sets up the WIG on their system, they will not receive a WIGAdmin.exe program in their Windows directory. However, the process of entering their name and mailbox name will automatically add them as a user to the WIG postoffice.





The main screen of the Wig Administrator program shows a list of users down the left hand side and a details window to the right hand side. Selecting a user from the left hand list will display that user’s details in the details window. The details window displays the user’s name, e-mail address, any forwarding options and the number of pending incoming and outgoing mail messages.





Viewing Pending Mail for all users





The Wig Administrator program lets you view pending incoming and outgoing messages for all users together. You can do this by selecting Pending Messages for all users from the View menu (or CTRL+M). This will pop up a list of messages:
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List of pending INCOMING and OUTGOING messages





You can list all the messages pending for unknown users. Do this by selecting Pending Messages for Unknown from the View menu (or CTRL+U).





Event Logging





WIG can log a certain number of events that occur during the process of sending and receiving mail. To display the event logging options, select Log Options from the View menu.
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Log Options dialog box





WIG lets you log events related to sending messages, receiving messages, auto responding and forwarding. From the Log Options dialog box, select the logging options you wish to record and press OK. All users who subsequently log onto MS Exchange will use these options and will start logging the events as required.





To view the event log, select Logged Events from the View menu or press CTRL+L. The WIG Administrator will show a list of events in date order, always displaying the most recent.
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Logged Events





This list can be updated by pressing the Recalc button. The list of events may be purged at any time by pressing the Purge button.





Adding Users





You can add a new user to the WIG post office either by installing the WIG onto the users machine and entering details via the installation program or by pressing the New User… button. Pressing this button will pop up the User dialog box.
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Details tab





Enter the name of the user into the Name field. Ensure that the MS Exchange user radio button is selected rather than the MS Mail user or virtual mailbox. The MS Mail user and MS Mail Gateway selections exist so that 16-bit MS Mail users can connect to the Internet. For more information on connecting MS Mail users to the Internet see, Using MS Mail with WIG later in this manual.








Virtual Mailboxes





You can create as many virtual mail boxes as you like regardless of the number of licenses that you have purchased. A Virtual mailbox is exactly the same as a normal MS Exchange user mailbox except you can’t log in as a virtual mailbox from MS Exchange. You can however forward mail sent to a virtual mailbox to a real MS Exchange user mailbox.





For example, suppose you were called John and you had an address john@company.com and suppose decided that you wanted to set up a mailbox for your customers to send enquiries to but ultimately you would be the person to read mail coming into this mail box. The solution would be to set up a virtual mailbox called enquiries and have all the mail sent to this mailbox forwarded to the MS Exchange mailbox john. For more information see Forwarding a User’s Mail later in this section.
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Address tab





The Address page lets you specify a mailbox name for the user. Normally, the mailbox name, together with the Workgroup address, go towards defining a users e-mail address. For example, if the workgroup node name was softalk.demon.co.uk and the user Simon Bates has a mailbox name stb then Simon Bates’s e-mail address will be stb@softalk.demon.co.uk.








Users with Domain names





Sometimes, a workgroup will have one or more domain names. The Workgroup Address drop list in the Address tab lets you choose which domain name will be used to make up the user’s e-mail address. For example, Softalk has a node name of softalk.demon.co.uk, but has a domain name of softalk.com . If the user Simon Bates wanted his e-mail address to be stb@softalk.com rather than stb@softalk.demon.co.uk, it would be a case of selecting softalk.com from the Workgroup address drop list.





Individual POP3 Mailboxes





If your workgroup uses POP3 to receive mail (rather than SMTP) from the Internet and a particular user has his/her own POP3 mailbox, which is different to the POP3 mailbox used by the workgroup then you may enter the details of the user’s POP3 mailbox in the User dialog box. If the address (to the right of the @ sign) is different from the workgroup address, then the differing address may be specified in the Address field in the User property sheet.. 





Note: If your workgroup has an e-mail account which supports multiple virtual mail boxes then the entire organisation can share the same POP3 account in order to send and receive mail. If you have a set of single user POP3 mail boxes, then you will need to add individual POP3 mail box information as described above.
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The POP3 tab





The POP3 page specifically lets users with individual POP3 mailboxes (see above) to enter their POP3 login name and POP3 password.





Forwarding a User’s Mail
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The Forwarding tab








The Forwarding page lets you forward a particular user’s mail to another person. This person may either be another WIG user, or it may be another e-mail address. The three radio buttons let you choose between not forwarding the mail at all, forwarding the mail to another WIG user and forwarding the mail to another user-specified address. If you select the Forward to user radio button, you can select from a list of WIG users. If you select the Keep a copy check box, WIG keeps a copy of the message with the original recipient before forwarding the message.





Adding a Signature
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The Signature tab





A Signature is the text placed at the bottom of all the mail messages that you send. You can either supply no signature, in which case you leave the text box blank, or supply something along the lines of the example above.








Changing a User’s Password





You can change a user’s password from the User property sheet by selecting the Details tab and pressing the Change Password button. When you do this a Change Password dialog box will appear.
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Change Password dialog box





Enter the user’s current password into the Password field and enter the same password into the Verify field.








Editing and Deleting Users





You can edit or delete a user by selecting the user from the list and pressing the Edit User… or Delete User… button respectively.





Editing Workgroup Information





You can edit the Workgroup details by selecting Edit Workgroup from the Edit menu. Alternatively, you can press CTRL+W. This will pop up a Workgroup property sheet.
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Workgroup Property Sheet





Your workgroup name will have already be specified in the setup process.  You may change it from the Name page.
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Address page





The Address page lets you enter the workgroup’s node name. This is often the same as the right hand portion of your e-mail address.  If your company has any Domain names, then enter these into the Domain names list, by pressing the New button. When you press the New button, a Domain dialog box will appear. Enter the new domain name and press OK.
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Domain dialog box








The POP3 page lets you enter POP3 information for the workgroup. If you have a POP3 account which supports multiple mailboxes then you would enter the login name and password for the account in this page. If the people in your workgroup have individual single POP3 accounts then leave these fields blank and ensure that the details are entered in each User dialog box. If you do not receive your e-mail using POP3 then leave these fields blank.
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POP3 page





The Administration page lets you specify the WIG administrator. Select the administrator from the list of users. If there is no administrator then select –No Administrator--.
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Administration page








WIG lets you forward incoming messages which do not match any of the existing virtual mailboxes. This will generally be useful for those workgroups who receive their mail from their service providers using SMTP rather than POP3.  With SMTP message reception, any messages sent to the correct node address will be received. For example anyone@softalk.demon.co.uk and POSTMASTER@softalk.demon.co.uk and stb@softalk.demon.co.uk would are all valid recipients of the softalk.demon.co.uk node name. If there were no WIG mailboxes set up for anyone and POSTMASTER, then these messages are classed as unknown users Any messages sent to unknown users may be forwarded to any WIG user or any other forwarding address.





The Forwarding page lets you forward unknown user’s mail to another person. This person may either be another WIG user, or it may be another e-mail address. The three radio buttons let you choose between not forwarding the mail at all, forwarding the mail to another WIG user and forwarding the mail to another user-specified address. If you select the Forward to user radio button, you can select from a list of WIG users. If you select the Keep a copy check box, WIG keeps a copy of the message with the original recipient before forwarding the message. It is not recommended to keep a copy of unknown users messages.
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Forwarding page





The License page lets you enter your password and keycode information needed to register WIG. When you buy a certain number of users, Softalk will send you a password and keycode. Enter this information in the relevant field. Also enter the exact number of users that you have purchased. When you press OK, provided that you have entered the information correctly, WIG will become registered.
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License page








Auto Responders





WIG lets you set up auto responders. An auto responder is a mail box to which people can send messages. On receiving the messages, the auto responder mail box will automatically reply to the sender with a specific message. The message may either be a simple text message or it may be a binary attachment.





To view a list of auto responders set up in WIG, select Responders from the View menu in the WIGAdmin.exe program. The list of users will be replaced by a list of responders.





To add a new responder, select New Responder from the Edit/Responder menu (alternatively press CTRL+R). A Responder property sheet will appear.
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Details page








The Address, POP3 and forwarding tabs show similar information to the User dialog box. This means that you can set up a responder to use its own POP3 mail box and you can forward mail sent to the responder on to another user or address. The Responder dialog box contains a File tab which lets you specify details about the information the responder will mail back to the sender.





�





The File Page





Use the browse file to select the file that you want to send. This can either be an ASCII text file or a binary file. If it is a text file, you can choose to send the text either as a text message, or as an attachment. If it is a binary file then you MUST attach the file rather than import the file into the response. If you select the Import file into response radio button and you specify a binary file, WIG will flag an error.








Node Names and Domain Names





If you receive your mail using SMTP rather than POP3 then you need to know your node name. If you have not registered a domain name then your node address (node name) will be the latter part of your e-mail address. For example, if your e-mail address is bob@softalk.demon.co.uk, then your node address is softalk.demon.co.uk. If you have registered a domain name (e.g. softalk.com), then your e-mail address may be bob@softalk.com, however the node address will still remain softalk.demon.co.uk. If you are in any doubt as to your node name then contact your Internet provider.





If you have a domain name, then this must be specified in the Address tab of the Workgroup dialog box in the WIG Administrator program. Also each user should select the relevant domain name in their Address pull down menu in the Address tab of the User dialog box in the Workgroup Administrator program. Doing so specifies how their address will appear to their recipients.








The WigUser Program





The WigUser program lets any user find out the status of messages they have sent from MS Exchange and messages they are about to receive from the JET engine database.





If a user sends a message from MS Exchange, he/she has no way of knowing whether or not the Gateway machine has sent the message. However, if the user runs the WigUser program, any messages sent by him/her that have not yet been sent to the Internet will be listed in the main window. Also, any messages coming in from the Internet, not yet received into the MS Exchange program, will be listed here too.





When you run up WigUser, you must select your name from the list of users and specify your password.
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Logon dialog box





When you have selected your name and entered your password, press OK. 


The WigUser window will then appear listing all the pending incoming and outgoing messages.
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WIGUser screen





You can look at pending mail for other users without coming out of the WigUser application. To do this, select Change User from the File menu. This will pop up the Logon dialog for you to select a different user. Of course you won’t be able to view another user’s pending incoming and outgoing mail unless you know the correct password.





Using MS Mail with WIG





WIG comes with additional components to let you send and receive Internet mail via MS Mail. 





Requirements





If you plan to use WIG to enable one or more MS Mail users to send and receive Internet mail then you must have a Windows 95 workstation available which may be used solely as a standalone WIG gateway for both MS Exchange and MS Mail users. This computer may not be used as a mail client. It may however be used to perform any non-mail related operations. You must also have an MS Mail post office which should be accessible from the Windows 95 gateway computer.





Setting up WIG to work with MS Mail





If you plan to set up WIG to work with MS Mail, it is most sensible to enable the WIG gateway machine to handle the sending and receiving of Internet mail for MS Mail users.





You must first create a user, using the WIGADMIN.EXE program and set the user type to be an MS Mail Gateway.
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Adding an MS Mail Gateway user entry





You do not need to purchase an extra user in order to add an MS Mail Gateway user. An MS Mail gateway user simply lets WIG store MS Mail messages against this virtual user. Address, POP3, Forwarding and Signature information is not relevant to an MS Mail Gateway user.








Setting up the Users in WIG





Next, you must tell WIG about the MS Mail users. You should do this by adding a user (of type MS Mail User) for each and every MS Mail user who wishes to send and receive Internet mail. Note that a user license is required for every additional MS Mail user. The name of the MS Mail user must match exactly the users full name as specified in the MS Mail post office. For example if the user’s name as specified in the MS Mail post office is Joe Bloggs, then Joe Bloggs must be specified as the user’s name in the Details tab of the User dialog box for that user.





Note: If the MS Mail user’s name (as entered in WIGADMIN.EXE) does not exactly match the users full name as specified in the MS Mail post office then WIG will not succeed in sending on that users Internet mail.





The Address tab of the MS Mail user’s User dialog box contains the users mailbox name and Workgroup address information. The mailbox name of the MS Mail user must match exactly the user’s mail box name as specified in the MS Mail post office. For example, if the users MS Mail address is MS:ACCOUNTS/PLUTO/JOHN then the mailbox name as specified in the User dialog box must be John.





Note: If the MS Mail user’s mailbox name (as entered in WIGADMIN.EXE) does not exactly match the users mailbox name as specified in the MS Mail post office then WIG will not succeed in sending or receiving Internet mail for that user.








Setting up an MS Mailbox for Internet messages





A mailbox should be set up in the MS Mail post office as a method of communication between MS Mail and WIG on the Windows 95 gateway machine. To do this, select Microsoft Mail Postoffice from Control Panel. The Microsoft Workgroup Postoffice Admin wizard will appear.
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Postoffice Administration





Press Next. The  In the next page, specify the post office location and press the Next button.





�





The next page asks you to enter you mail box name and password





�





Specify your MS Mail box name and password and press the Next button. The Postoffice manager dialog box will appear.
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Post office Manager dialog box





Add a User INTERNET specifying an empty password, such that the user INTERNET appears in the user list, as in the dialog box above.





Note: It is important that you leave the password field empty. If you do not, WIG will not be able to send and receive mail to and from MS Mail users.
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Adding a user INTERNET








Setting up the Gateway Machine





Next, the gateway machine must be set up with two profiles. One of the profiles should be called INTERNET. The other profile must be set as the computer’s default MS Exchange profile. It may be called anything. For clarity, it makes sense to create a new profile called WIG. Whatever you call the profile (we strongly recommend WIG) it should be set as the default MS Exchange profile. You can set it as the default profile by selecting the profile from the drop down list at the bottom of the General tab.





Creating the WIG profile





You can add MS Exchange profiles by selecting Mail and Fax from Control Panel and press the Show Profiles button. The MS Exchange profiles dialog box will appear. 
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MS Exchange profiles dialog box





Press the Add button. The Inbox Setup Wizard will appear. Select Manually configure information services.  Press the Next button.
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Inbox Setup Wizard





Specify the name WIG for this profile. Then press the next button.
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Profile Name page








When you press the Next button the WIG Properties dialog box will appear. Press the Add button and select the Workgroup Internet Gateway service from the list of services.
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WIG profile properties





When you select the Workgroup Internet Gateway service, the Internet Gateway settings dialog box will appear. Select the 16-bit Internet gateway user than you created earlier.
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Internet Gateway Settings





Specify all your gateway options in the other tabs as described earlier in this manual. Now, since you have selected an MS Mail gateway user, you will have access to the option in the MS Mail tab of the Internet Gateway Settings dialog box.
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MS Mail tab





Check the Check the MAPI database every check box and specify a period representing how often WIG will check for messages sent by MS Mail users.





Next, you must add the Microsoft Mail service to the WIG profile. 
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Adding the Micorosft Mail service








When you add this service the Microsoft Mail dialog box will appear. Go to the logon tab and enter the mailbox name as INTERNET. Leave the password field blank.








Creating the INTERNET profile





The final stage is to add the INTERNET profile. This is the same process as adding the WIG profile, except the Workgroup Internet Gateway service must not be added to this profile. Instead, the Microsoft Mail service should be added, just as you added the Microsoft Mail service to the WIG profile. Remember to go to the Logon tab and specify INTERNET as the mailbox name and to leave the password field blank. 





Note: You must not add the Workgroup Internet Gateway service to the INTERNET profile. If you do, unexpected results may occur.





Next you must add the Personal Folders service. This ensures that the Microsoft Mail service can temporarily store messages in the INTERNET mailbox on their way to and from MS Mail users. The INTERNET properties dialog box should be set up as below.
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Internet Properties








Setting up the WFWG Client





An additional setup program called SETUP16.EXE is provided with the WIG product. You will find it in the WIG16.ZIP file included in the WIG.ZIP file. Running this setup program on a Windows for Workgroups 3.11 client PC will enable the MS Mail client on that machine to send and receive Internet mail





When you run the program, you will be greeted with the following dialog box:





�





MS Mail Internet Gateway








Press Continue. The MS Mail extension DLL will be copied to your computer and the MSMAIL.INI file in your Windows directory will be modified to load the DLL when MS Mail starts up.





When the setup program has successfully completed, try running up MS Mail under Windows for Workgroups and try sending a message to an Internet address. When you send the message, the MS Mail extension will recognise that the addressee is an Internet mail addressee and will repackage the mail message, such that it gets sent to the INTERNET mailbox, but embeds the addressee information in the body of the message. WIG will extract this information and rewrite the body as you originally intended it.





Sending Mail from MS Mail





You can send messages as usual from MS Mail. When you compose the message, enter Internet mail addresses separated by semicolons.





�





You can send mail, reply to mail, forward mail, select Internet recipients from the address book and check addressee information all quite seamlessly. Remember, that in order for Internet mail transfer to occur with MS Mail users, the MS Mail user must be setup in the WIG Administrator and the gateway machine must be setup with the two profiles as described above.�
Appendix A - How to License WIG








Using the Registration program





Upon installation you should register WIG by running the Registration program included.  This program is called igreg.exe and can be found in the local Windows directory.  You can access this from the desktop by double clicking on the icon in the WIG program group.  This program will also be run automatically when your trial license expires, please ignore this if you have already registered.
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Registration dialog box





To register, press the Register button. This will display a registration form:
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Registration form





Fill in the relevant fields and press OK. This will send us an e-mail message containing these details.  Upon receipt of this message you will be sent a Personal Reference Number by return which will qualify you for free e-mail and fax support.





Purchasing WIG Licenses





In order to permanently activate WIG for the desired number of users and to activate the ability to send binary attachments, a limitation of the evaluation system, the relevant number of licenses must be purchased from Sareen Software.  After receiving payment for the licenses we will e-mail you a password and unique registration key.  Details of how to enter these into the WIG Administrator Program to permanently unlock and register WIG will also be sent.





Payment for WIG licenses can be made by credit card, cheque or direct fund transfer to Sareen Software Plc.  We currently accept VISA, Mastercard and American Express and will accept purchase orders from UK based companies.  For further details, current pricing or to order WIG please contact us on +44 (0)181 423 9434 or from the US on 1 800 747 5914.





Join Our Mailing List





If you wish to join our mailing list which will keep you updated on the latest products from Sareen Software Plc and Softalk Ltd just run the Register program and press the Join button on the Registration dialog box.


�
Appendix B - Windows 95 Configuration Information





Adding people to your MS Exchange Address Book





To add an Internet recipient, select Address Book from the Tools menu in MS Exchange. The Address Book dialog box will appear. Select New Entry from the File menu. A New Entry dialog box will appear.
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New Entry dialog box





Select Other Address as the entry type and press OK. A New Other Address Property sheet will appear:
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New Other Address Property Sheet





Enter the recipients full name into the Display Name field. Enter the Email address and then enter SMTP into the E-mail type field.





Note: You must enter SMTP into the Email type field otherwise the Workgroup Internet Gateway will not send messages to this recipient.





Once you have entered the recipient into your address book, you will be able to send messages to that recipient.





Installing Dial-Up Networking in Windows 95





The Workgroup Internet Gateway uses the Dial-Up Networking support provided by Windows 95. The gateway requires that a dial-up connection to your Internet provider already exists.





To install Dial-Up networking, run up the Control Panel. Control Panel may be found under Settings in the Start menu.
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Control Panel





Double click on Add/Remove Programs. The Add/Remove Programs property sheet will appear. Select the Windows Setup tab and double click on the Communications entry.
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Add/Remove Programs property sheet





The Communications dialog box will appear. Select the Dial-Up Networking check box and press OK. Windows will then install Dial-up networking.
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Communications dialog box





If you did not have Dial-Up networking installed when you ran the Setup program, you would not have been able to select a dial up connection, needed to connect to your Internet provider. The following section describes how to Create a new Dial-Up connection and how to tell the Workgroup Internet Gateway to use that connection.








Creating a new Dial-Up Connection





From the Start menu, select Programs/Accessories/Dial-up Networking. The Dial-up Networking program group will appear.
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Dial-up Networking program group





Double click on the � icon. By using a Make New Connection wizard, Windows will guide you through the process of making a new Dial-up connection.








Installing TCP/IP Networking





In order to communicate with your Internet provider’s computer, in addition to installing a dial-up network (for connecting to an Internet computer), you must also be able to talk its language (protocol). The protocol used by computers over the Internet is called TCP/IP. TCP/IP networking comes as part of Windows 95. This section describes how to set up TCP/IP Networking.





To install Dial-Up networking, run up the Control Panel. Control Panel may be found under Settings in the Start menu.
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Control Panel





Double click on the Network icon. The Network dialog box will appear.
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Network dialog box





Press Add on the Network dialog box. A Select Network Component Type dialog box will appear. Select Protocol and press Add.
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Select Network Component Type dialog box





When you press Add the Select Network Protocol dialog box will appear. Select Microsoft from the Manufacturers list and select TCP/IP from the list of Network protocols.
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Select Network Protocol dialog box





Finally, press OK. You will be returned to the Network dialog box. Press OK again. Windows will ask you to reboot your computer which you should now do. When you re-enter Windows, TCP/IP Networking will be installed.
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